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ETABS v21.2.0 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 28-November-2023

This document lists changes made to ETABS since v21.1.0, released 11-August-2023. Items marked with
an asterisk (*) in the first column are more significant.

Analysis
Enhancements Implemented
* Ticket Description

5055 An enhancement has been implemented that now accounts for section property I23
(product of inertia) in the analysis. Previously, I23 value was being ignored when creating
the analysis model. Analysis results may differ for affected models compared to previous
versions. Additionally, the I23 section property has also been now exposed in the frame
section properties form and the database table. The value of I23 is automatically calculated
for angle sections and Section Designer sections, and it can be manually specified for general
sections. For all other sections, I23 is zero. For general section, a negative value is also now
allowed for I23 on the section properties form and through interactive editing and API.

* 9948 An enhancement has been made to speed up direct-integration time-history load cases with
additional modal damping specified that is using a large number of modes. Note that in spite
of this speed enhancement, it is generally not recommended to use too many modes for
additional modal damping. For building structures, the higher-frequency modes typically
respond statically to seismic and wind loading, and stiffness proportional damping is more
efficient for the damping at high frequencies. This decision is up to the judgement of the
engineer.

* 10079 An enhancement has been made to allow the “Number of (Internal) Threads for Analysis"
setting to also control number of threads that can be used by the Multi-threaded Solver.
This provides more control to limit the number of processors that are used when running a
given model, particularly useful on machines with a very large number of available
processors, some of which may needed for other tasks.

Database Tables
Enhancements Implemented
* Ticket Description
* 9892 The following "Analysis Results" database tables have been parallelized for increased speed

during display or export: "Joint Displacements, "Joint Displacements - Absolute", “Joint
Drifts", "Pier Forces", "Pier Force Status", "Spandrel Forces, and "Spandrel Force Status". In
addition, individual table progress will now be displayed in the status bar while filling any of
the “Analysis Results” tables for display/export. The progress bar is effective for tables that
take significant time to display/export.

Design – Composite Beam
Enhancements Implemented
* Ticket Description

9846 Composite beam design was enhanced where the Display Composite Beam Design Info form
now features an option to display the live load reduction factors used when the beams were
designed.

10016 The Composite Beam Design Overwrites form has been enhanced to now include toggle
fields that specify whether the following composite beam attributes are calculated
automatically or are instead user-defined: live load reduction factor, deck section, deck
orientation, deck width, floor width, floor length and free-edge flag. Furthermore, the
automatically calculated value of any attribute is now displayed. Previously to make these
values automatically calculated, they had to be set to zero in the form or selected as
"Program Calculated" from of list of possible values.
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* Ticket Description
10132 Several related enhancements to composite beam design have been implemented: (1.) The

calculation of cantilever deflections under loads other live loads has been refined to include
the tilts produced by the rotations of their supported ends. (2.) Cantilever backspans are
now designed to limit the connected cantilever tilts. (3.) The computation of backspan
deflections has been refined to use the moment of inertia of the steel section instead of that
of the composite section in areas of negative bending. (4.) When activated from the
Interactive Composite Beam Design form, the Diagrams form now shows cantilever
deflections as displacements relative to the cantilever support measured along the global z-
axis. (5.) When activated from the Interactive Composite Beam Design form, the Diagrams
form features a checkbox to display backspans shear, moment, and deflection based on a
partial loading of the cantilever. (6.) When activated from the Interactive Composite Beam
Design form, the Diagrams form features a checkbox to display cantilever deflections with or
without live load on the cantilever (in conjunction with live load or a partial live load on the
backspan).

Design – Concrete Frame
Enhancements Implemented
* Ticket Description

10006 An enhancement has been made to include Tan(Theta) in the design overwrites for the
Eurocode 2-2004 and Italian NTC 2008 concrete frame designs where Theta is the angle
between the concrete compression strut and the frame member axis perpendicular to the
shear force. The range of Tan(Theta) is between 0.4 and 1.0 as specified in Section 6.2.3(2)
in EN 1992-1-1:2004.

Design – Steel Frame
Enhancements Implemented
* Ticket Description
* 8230 Steel Connection Design based on the AISC 360-10 and AISC 360-16 codes has been added.

Beam-Beam, Beam-Column and Column-base connections are covered. Both welded and
bolted connections are included. Step-by-step calculation reports are produced for each
limit state. Documentation and verification examples are available.

9994 An enhancement has been made to the Eurocode 3-2005 steel frame design to update the
design according to Corrigendum 2 released in 2009. These updates include: The calculation
of npl and Czz in Annex A. Shear area of rolled T-section for load parallel to web in section
6.2.6 (3c). Previously the shear area was calculated as 0.9*(A-b*tf). Cm,z in Table B.3 for the
case Cm,z = 0.9 + 0.1*alpha_h*(1+2*psi). Previously it was Cm,z = 0.9 -
0.1*alpha_h*(1+2*psi). Demand/Capacity ratio calculation according to section 6.2.9.1(6)
for circular hollow section (pipe section). Previously, Equation 6.41 was not included in
calculation of D/C ratio for the pipe. Now, it is calculated for pipe section and the moment
capacity M_N,y,Rd = M_N,z,Rd = Mpl,Rd*(1-n^1.7) is also implemented. Items 3 and 4 have
also been implemented for the Italian NTC 2018 and 2008.

10020 An enhancement has been made for the Eurocode 3-2005 steel frame design to update the
name of the design code to the official one, "EN 1993-1-1:2005/A1:2014." In addition, the
official name of the national annex name is updated. This change to official code name is
shown in the design preferences, the design detail report, and design results tables. Any
user-developed scripts or other automated procedures that reference the affected database
tables, including tables accessed through the API, will need to be updated to reference the
new table names.

10086 An enhancement has been made to the CSA S16-19, CSA S16-14 and CSA S16-09 steel frame
design codes to add the warping torsional constant, Cw, to the design overwrites. The value
can be modified via the overwrites form, database tables, and API functions.
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External Import and Export
Enhancements Implemented
* Ticket Description

9895 The feature to export an ETABS model as a Perform3D model (File menu > Export >
Perform3D Structure File) has been enhanced so that frame objects that are assigned a Pier
or Spandrel label will be exported to Perform3D in separate element groups based on their
Pier or Spandrel label names. This can be useful, for example, where it is desired that
coupling beams be in a separate group from other beams.

9899 Two-joint links of certain types are now exported from ETABS to Perform3D. Only the
geometry is exported, and a corresponding property with zero values is created in
Perform3D. Proper numerical values of the properties can be specified in Perform3D after
importing the model. The following types are exported: (1.) ETABS "Damper - Exponential" >
Perform3D "VBAR Inelastic component", (2.) ETABS "Gap" and "Hook" > Perform3D "1D
Inelastic Bar", (3.) ETABS "Rubber Isolator" and "Friction Isolator" > Perform3D "ISOL
Inelastic component".

9901 The feature to export ETABS models as a Perform3D model (File menu > Export > Perform3D
Structure File) has been expanded to include shell uniform loads in the global coordinate
system. These loads will be exported to Perform3D as lumped nodal loads on the nodes
which form the shell elements.

9903 The "Export to Perform3D Model" functionality has been expanded to include the export of
Line and Quad gauge elements. Translational type line gauges in ETABS will be exported as
Perform3D Axial Strain Gage (2-node) components. Rotational type line gauges in ETABS will
be exported as Perform3D Rotational Gage, Beam Type (2-node) components. Shear type
quad gauges in ETABS will be exported as Perform3D Shear Strain Gage (4-node)
components. Rotation type quad gauges in ETABS will be exported as Perform3D Rotation
Gage, Wall Type (4-node) components.

9935 An enhancement was made to allow selection of the tower while importing from a .DXF file
to the Architectural layer for the multi-tower case. Previously all layers were added to the
first tower.

Graphics
Enhancements Implemented
* Ticket Description

9987 A new menu command has been added, Options > Graphics Mode > Video Card(s)
Information, which will display the available video (graphics) cards present on the computer,
along with their GPU memory. The graphics card currently in use by ETABS is indicated, as
well as its compatibility for use with DirectX graphics mode in ETABS. Windows Control
Panel can be used to select a different graphics card for use next time ETABS is started.

Installation and Licensing
Enhancements Implemented
* Ticket Description

9920 The version number has been changed to 21.2.0 for a new intermediate release.
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* Ticket Description
* 10138 An enhancement has been implemented to provide a new licensing option, "Cloud Sign-in"

licensing, that utilizes user credentials to access licenses instead of activation keys. This
licensing option can be selected when installing the software, and can be changed later by
running the CSiLicenseAssistant from the Windows Start menu or found in the CSILicensing
subfolder of the ETABS installation folder. With this licensing option, user credentials will be
requested when ETABS is first started, unless they have already been supplied in an earlier
session of ETABS or another CSI software product that uses Cloud Sign-in licensing. User
credentials can be obtained from the customer's IT or other department that manages
software access. Cloud Sign-in licensing requires an active internet connection while running
the software. A commuter-license option is available which allows checking out a license for
a time period up to 30 days, subject to the user's company policy, for use of the software
without an internet connection. Until the commuter license is checked back in or the time
period expires, no other user will have access to that license. Customers can use the CSI
Customer Center to manage which users have access to various CSI products and product
levels through user groups. The CSI Customer Center also provides tools to view license
usage. Access to these features in the CSI Customer Center is subject to permissions set by
the customer's department that manages software access.

Loading
Enhancements Implemented
* Ticket Description
* 8957 The auto-seismic load pattern and response-spectrum function were added for the

Malaysian National Annex of Eurocode 8-2004.
10036 The TSC-2018 response-spectrum function has been enhanced to allow specification of the

R, D and I parameters. The new parameter values will be set to 1.0 when opening models
from versions prior to ETABS v21.2.0 to ensure that results are not changed. The values can
be updated in the response-spectrum function definition after opening older models in the
new version, if desired.

Results Display and Output
Enhancements Implemented
* Ticket Description
* 9771 An enhancement was made to allow the user to disable the saving of individual fiber analysis

results for Fiber P-M2-M3 hinges assigned to frame or wall objects, thereby reducing the
amount of results data that is saved for each step. This option is available in the "Frame
Assignment - Hinges" form (Assign menu > Frame > Hinges) and can be assigned on a per-
hinge basis for User Defined type Hinge Deformation types. For wall hinges,this options is
available in the "Shell Assignment - Hinges" form (Assign menu >Shells > Wall Hinge) and can
be applied to both vertical and general shear wall hinges. When the saving of individual
fibers is disabled, the results for the affected hinges, including state and status, will be
available but the option to view individual fiber results will be disabled in the Hinge Plots
form as well as in the "Fiber Hinge Fiber States" output table. This option is intended for
models with a large number of fiber P-M2-M3 hinges where the user may not be interested
in viewing detailed fiber results for all hinges.

9956 An enhancement has been implemented to allow users to specify different diagram fill
colors for range positive and range negative values when plotting frame forces/stresses for
multi-valued load cases and combinations. Previously, the program was always using same
fill color for positive and negative values. The plots in the extended frame force diagram
form (accessed by right-clicking the frame in the GUI) have also been updated for the above
change.
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Structural Model
Enhancements Implemented
* Ticket Description
* 9630 The frame hinge assignment feature has been enhanced with four new preset hinge

assignment distribution types: (1.) Beam Column, which adds a moment or PMM hinge at
the ends of the frame object. This is intended to be used for most typical beam and column
members which are governed by flexural behavior and expected to yield at one or both ends
of the member while maintaining elastic or nearly elastic behavior at the mid-span. (2.)
Distributed Plasticity, which adds hinges along the length of the frame object based on a
specified integration rule. This is intended to be used for frame objects that are expected to
have complex yielding behavior over the entire length. (3.) Equal Spacing, which adds hinges
at a fixed spacing along the length of the frame object. Similar to the Distributed Plasticity
option, this is intended to be used for frame objects with complex yielding behavior but may
be used where yielding is expected to be evenly distributed or concentrated at mid-span.
(4.) Continuous Support, which adds one hinge at the center of every frame element
associated with the selected frame object. This is intended to be used for piles or grade
beams, which are supported by springs at specified intervals and are meshed at the
intersection with these supports, to facilitate the placement of hinges between each
support. A User Defined hinge distribution type is also available to allow free-form
assignment of hinges, which corresponds to the previous method of hinge assignment.
When a model from a previous version of the program is opened, the hinge assignment is
automatically translated as a User Defined hinge distribution. A new Hinge Length Overwrite
parameter is available for hinge assignments using User Defined hinge distribution type. This
parameter overwrites the hinge length of the assigned hinge with either an absolute length
or a relative length as a ratio to the clear length of the frame object. The overwrite is
intended to facilitate the use of Fiber or strain/curvature-type hinge properties in multiple
locations or frame objects without having to redefine the hinge property to change the
hinge-length setting. The database table "Frame Assignments - Hinge - Distribution Type"
has been added to the interactive database. This table can be used to view or edit the hinge-
distribution types for the frame hinge assignments. Additionally, the database tables Frame
Hinge Assignments hinge types have been updated to include the new Hinge Length
Overwrite parameters.

10155 An enhancement was made for the CoreBrace BRB section where the torsional end release
is now a user assignment. Previously any assigned torsional release was ignored and
torsional continuity was enforced.

User Interface
Enhancements Implemented
* Ticket Description

10070 An enhancement has been implemented to allow drawing a linear tendon throughout
between two points. Two options are now available in the Drawing Properties window for
the vertical profile when drawing a tendon: (1.) Linear Throughout - This option will draw a
tendon with a linear vertical profile between two clicked points irrespective of any support
lines, strips, grids, etc. that intersect the line joining the two clicked points. Column supports
on the line are also ignored. (2.) Program Determined - With this option, the tendon is
generated as before, where support points are automatically traced and the vertical profile
for tendon segments is determined by the program. The default option is "Program
Determined", which was always the previous behavior.
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Analysis
Incidents Resolved
* Ticket Description

6555 An incident was resolved where Linear Modal and FNA time-history load cases with
acceleration loads that have a non-zero angle would report reaction forces that did not
account for the angle of the acceleration loads on masses at restrained degrees of freedom.
This issue only affected restrained degrees-of-freedom and only affected the base reaction
and joint reaction results. Other analysis results were not affected.

Database Tables
Incidents Resolved
* Ticket Description

10150 An incident was resolved where the column filter for a database table would cause an
abnormal termination of the software if the filtered value included a single quote (')
character.

Design – Composite Beam
Incidents Resolved
* Ticket Description

9852 An incident was resolved for composite column design code “Chinese 2010” where the
design reported large values of VS-ratio a/D_major and a/D_minor for a concrete-filled
tube/pipe, even though the column had in-span loading. Now the design checks for a change
in shear force within a design station due to the design load combination and point load
applied to the line object in local-2 or/and local-3 axes.

9986 An incident was resolved for composite beam design where the floor width and length of
some beams were miscalculated and set too low when composite beam designs were
assessed for vibrations in models with the following characteristics: (1) the floor slab edges
were located right above the centerlines of the peripheral beams, and (2) the floor slab
edges had highly articulated, non-convex, shapes. This miscalculation only affected beam
designs governed by vibrations, it was documented in the output, and it was conservative
since ETABS selected heavier sections than necessary. Floor width and length are now
properly computed even in models presenting characteristics (1) and (2) above. Correct
vibration assessments could be obtained by overriding the values of the floor length and
width in the composite beam overwrites. All versions of ETABS that compute floor length
and width when assessing composite beam vibrations were affected.

Design – Concrete Frame
Incidents Resolved
* Ticket Description

9924 An incident has been resolved that addressed several issues for the serviceability/crack-
width design of concrete frames per the Eurocode 2-2004 and Italian NTC 2008 codes: (1.)
An error message could be displayed indicating a problem calculating the tension area for
the section when multi-processing was utilized. After clicking OK, design would proceed but
the design results could be incorrect. This problem did not occur for single-processing of
design. (2.) The time to run the design was sometimes longer than expected due to
unnecessary calculation of unused design parameters. The speed is now much improved.
(3.) For the display of the Serviceability Crack Width Ratio, Serviceability Concrete Stress
Ratio, and Serviceability Steel Stress Ratio, the ratio was sometimes displayed inside
parentheses. This was related to whether or not the longitudinal reinforcement was to be
designed or checked, but was not relevant to the various ratios. The displayed values of the
ratios were correct regardless of whether the parentheses were shown or not.

9984 An incident was resolved for concrete frame design per Eurocode 2-2004 where the column
shear rebar for was excessively high for ductility class medium (DCM), ductility class low
(DCL), and Secondary frames. This issue affected v20.0.0 to v21.1.0.
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* Ticket Description
9998 An incident was resolved for Chinese 2010 concrete frame design where modification

factors of Seismic Design Grade II transition column seismic axial force was used as1.3
instead of 1.2.

9999 An incident was resolved for Chinese 2010 concrete frame design code where horizontal
seismic forces (i.e. moments and shears) in the design combination of transfer beam are
now amplified by 1.9, 1.6 and 1.3 factor respectively for SuperI, I and II class (JGJ 3-2010
10.2.4).

10000 An incident was resolved for Chinese 2010 concrete frame design where MMF and SMF
factors were incorrectly reported for middle story column when ACR ratio was less than
0.15. This was only a reporting item and design results were not affected.

10027 An incident was resolved for the shear design of columns according to the Italian NTC 2008
concrete frame design code in which the alpha_c factor was not correctly determined as
described in Section 3.5.2.2 of the design manual. In particular, for the case where the
column was under tension, alpha_c was previously not taken to be equal to 1.0. In addition,
VRcd was not calculated using the optimized value of TanTheta.

10050 An incident was resolved for the steel frame design codes "Eurocode 3-2005", "Italian NTC
2018", and "Italian NTC 2008" where the psi parameters were not calculated correctly for
the section classification of Tee sections when a member was under major axis bending
moment. The stress at the top of the web was being calculated at the top of the flange. Now
it is calculated at the bottom of the flange. The stress at the bottom of the web was
calculated correctly. This affected the calculation of psi and then k_sigma per EN 1993-1-
5:2006 Table 4.2. This error could affect the PMM ratio if the resulting section classification
was different.

10128 An incident was resolved for concrete frame design per the Eurocode 2-2004 code where
the warning message "Joint shear exceeds limit" could be shown for DCM frames, even
though this warning message is not applicable for DCM frames.

Design – Shear Wall
Incidents Resolved
* Ticket Description

9992 An incident was resolved for Chinese 2010 wall design where the overwritten middle zone
vertical reinforcement ratio of piers was reset to the default value during wall design.

10137 An incident was resolved for shear wall design where spandrel design overwrites were not
available for the AS 3600-2009 code, while for the AS 3600-2018 code the overwrites were
available but the overwrite "Consider Vc?" was not working.

10173 An incident was resolved for shear wall design code AS 3600-2018 where spandrel shear
design reported shear rebar that could be incorrect when the model default database units
were not in N-mm. Note that the database units are the consistent units in effect when the
model was created and that are reported in the analysis .LOG file.

Design – Steel Frame
Incidents Resolved
* Ticket Description

9910 An incident was resolved for the CSA S16-19 and CSA S16-14 steel frame design codes where
the moment ratio was not determined correctly for calculating the unbraced-length limit
according to Section 13.7 for the design of sections in tension. Now the design determines
the two ratios of (1) the major-axis bending moment over the segment braced against
lateral displacement (minor-axis bracing) and (2) twisting (lateral-torsional buckling, LTB
bracing) separately, computes the two laterally unsupported distances (Lcr), and compares
with the corresponding unbraced length of the member to determine whether or not the
unbraced length satisfies the requirement. For the moment diagram being non-linear over
the considered segment, the value of Kappa will be taken as zero.
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* Ticket Description
9936 An incident was resolved in steel frame design where the KL/r calculated for special

concentrically braced frames and ordinary concentrically braced frames were incorrect for
seismic design. The major direction KL/r was being calculated as K_minor*L_major/r_major
and the minor direction KL/r was being calculated as K_major*L_minor/r_minor. In those
cases, K_major and K_minor were switched. The affected codes were AISC 360-16, AISC 360-
10, AISC 360-05, CSA-S16-19, CSA-S16-14, CSA-S16-09, Eurocode 3-2005, Italian NTC 2018,
Italian NTC 2008, Indian IS 800:2007, KBC 2016, and KBC 2009. The use of KL/r for
compression capacity calculations was correct.

9937 An incident has been resolved for the CSA S16-19 and CSA S16-14 steel frame designs in
which the seismic design (or checks) is not performed for member with framing type of LD
CBF(V), LD CBF(TC), LD CBF(OT), LD CBF(TO), MD CBF(V), MD CBF(TC), MD CBF(OT) or MD
CBF(TO). These seismic design checks include axial load, compactness, slenderness, joint
design for doubler plate, panel-zone shear check, and beam/column capacity ratio,
connection shear and/or axial force.

9982 An incident has been resolved in certain steel frame design codes in which the member is
now red-flagged when it faces an error and a warning condition simultaneously. Previously,
the warning condition sometimes superseded the error condition, and the member was not
shown in red. For example, when the member is part of an SMF in the “AISC 360-16” code,
and the section is not highly ductile compact (b/t > Lambda_hd), the program considers the
condition an error. However, the program considers the condition l/r > 60 as a warning.
When the column section is not highly ductile, it is reported as an error, and the member is
shown in red. When the column section satisfies both the error conditions: (1) the section is
not highly ductile, and (2) the l/r > 60, the second condition was taken as a warning, and it
erroneously superseded the error; the member was NOT shown in red. This error is now
fixed. The affected codes are"AISC 360-16", "AISC 360-10", "Eurocode 3-2005", "Italian NTC
2018", and "Italian NTC 2008".

10022 An incident has been resolved for the Eurocode 3 and Italian NTC 2008 and 2018 steel frame
designs in which the calculations related to the fillet radius for Tee sections such as shear
area long z-axis (2-axis) and effective section modulus for bending about y-axis (3-axis) were
slightly over-conservative due to incorrect value of the fillet radius. In addition, the checks to
ignore global buckling effects on compression capacity according to Section 6.3.1.2(4) in EN
1993-1-1:2005 are removed, resulting in more conservative design.

10054 An incident was resolved for the AISC 360-16 and AISC 360-05 steel frame design codes
where the flexural strength of wide flange sections considering lateral-torsional buckling was
incorrectly calculated. This was due to the torsional constant, J, being taken as zero because
the ratio Iyc/Ix was used instead of Iyc/Iy in the check for being less than or equal to 0.23.

Detailing
Incidents Resolved
* Ticket Description

9970 An incident was resolved for where the clear cover specified using the beam editor in
concrete beam detailing was being ignored.

10041 An incident was resolved to link the concrete beam/column section cover with detailing by
taking the side cover as the top cover.

Drafting and Editing
Incidents Resolved
* Ticket Description

1910 An incident was resolved where modifying the curved edge of a shell object using the
"Reshape Object" tool button or command was not working correctly.
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External Import and Export
Incidents Resolved
* Ticket Description

9634 An incident was resolved where ETABS frame point loads at ends were not transferred to
Perform3D nodes during exporting data from ETABS to Perform3D.

9928 An incident was resolved to remove the File > Export to CSiDetail menu item, which is no
longer in use as the detailing is now directly accessed from inside ETABS.

10023 An incident resolved where a Revit project that featured family names consisting of only one
or two characters was imported in ETABS, the resulting model could not be exported back to
Revit. Attempts to export the .EXR file produced an error message and no .EXR file. The
workaround was to save the ETABS model to .e2k, re-import in ETABS, and export that to
Revit, or rename the families with only one or two characters in their names and create a
new ETABS model. ETABS 2016 and later were affected.

10090 An incident was resolved where ETABS did not import CIS/2 files with measures in units that
had prefixes other than milli, centi, kilo, or mega. For example, ETABS could not import a
CIS/2 file in which masses were measured in decigrams. When this occurred the error was
obvious: an error message was displayed and no model was created. The full range of CIS/2
unit prefixes, from 'atto' to 'tera', is now supported.

Graphics
Incidents Resolved
* Ticket Description

8950 An incident was resolved where horizontal floor area objects were not extruded at the
correct Z elevation when the area object was not at a story level. This was a display issue
only and did not affect results..

10135 An incident was resolved where the displayed cross-sectional shape of columns shown in a
plan views was not drawn in the correct location for unsymmetrical sections (like angles and
channels). This only affected the plan view when the Extruded View option was turned off.
The Extruded View was shown correctly in 3-D and in plan views.

Loading
Incidents Resolved
* Ticket Description

8362 An incident has been resolved where selecting a Response Spectrum based on the Italian
NTC2018 using Latitude and Longitude values may in some cases result in an abnormal
condition and in some other rare cases may select values that are interpolated from known
values that are not the closest to the specified location. In such cases the differences were
small.

10034 An incident was resolved for the Eurocode 8-2004 auto seismic load pattern where
parameters Tb, Tc and Td were set to default values when the *.$ET or .E2K text model files
were imported for Country "Other". Results agreed with the model as imported.

10057 An incident was resolved where models with PT tendons in beams would, in rare cases, give
an error message during analysis that the PT loads were not self-balancing. This could
happen when the tendon was close to another beam crossing at an angle. The unbalance
was in the moments, and was usually very small.

10105 An incident was resolved for the ASCE 7-22 auto-wind load pattern where the directional
factor (kd) was applied twice. This caused an unconservative wind load when kd was less
than unity.
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Miscellaneous
Incidents Resolved
* Ticket Description

9820 An incident was resolved where the thumbnails for ETABS models were not saving correctly
in when DirectX graphics mode, sometimes including images from other windows on the
screen when the model was closed.

Results Display and Output
Incidents Resolved
* Ticket Description

1432 An incident was resolved where the M2 values reported in the table "Section Cut Forces -
Design" were negative for Response Spectrum load cases. Additionally, negative values were
shown in Envelope results. This issue was a reporting issue and only affected design-type
section cuts.

2228 An incident was resolved where the Capacity Spectrum conversion of the Pushover curve
based on the FEMA 440 Equivalent Linearization method was not correct for loading not in
the X or Y planes or if a generalized displacement was used for monitoring.

9785 An incident was resolved where the Internal Hysteretic Damping energy for Link objects with
a MultiLinear Elastic type property was incorrectly reported as non-zero values for nonlinear
load cases. This was an energy-reporting issue only and did not affect any other results.

9940 An incident was resolved for steel frame design codes AISC 360-16, AISC 360-10, and NTC
2008 to correctly display the unbraced length for minor bending (or buckling) in the right-
click design details. Previously, the value of the unbraced length for minor bending of the
station that governed the design was shown in the design report for all stations. It is now
correctly shown for the selected design station. This was only display issue. The design
results were calculated using the correct unbraced length for minor bending.

9952 An incident was resolved for composite beam design where the software could terminate
abnormally when trying to generate a report or export tables that included the table for
composite beam design preferences in the particular case where the design preference for
vibration acceptability criteria was set to "sensitive equipment". The design results were not
affected, and the error did not occur for reports or sets of tables that did not include the
table for composite beam design preferences. This incident affected ETABS 2017 and later.

9968 An incident was resolved where the Project Report was not able to sent to a printer or to
Word when all the columns of any of the exported tables could not be fit in on a single page,
but needed a vertical split. An example of such a table is Steel Frame Design Overwrites.

9997 An incident was resolved where an abnormal termination error may occur when viewing
hinge results (Display->Hinge Results) for P-M2-M3 hinges for a degree-of-freedom that has
extremely small deformations, typically the axial direction. This was an issue with displaying
the plot only and does not affect analysis results.

10046 An incident was resolved where the images sent to a physical printer using the command
File > Print Graphics command did not always use the correct margin settings. This did not
affect graphics printed to PDF files.

10058 An incident was resolved where the option "Show Contours in Plan View for Floor" was not
available when an area load was assigned using Area Load Sets only. This was just a display
issue and the loads were applied correctly.

10083 An incident was resolved for shear wall design per the Chinese 2010 code where the "Right
Edge member width", "Area of steel Left" and "Area of steel Right" in the “Table: Shear Wall
Pier Design Summary Table” were incorrectly displayed as 0. Also, the boundary zone width
was not shown for the right-side boundary element using Display Design Information > Pier
Edge/Boundary Zone Widths. These were all reporting issues and the actual design was not
affected. The results were shown correctly in the details shown by right-clicking on the pier.

10151 An incident was resolved where story plots for maximum drifts for load combinations
involving multi-step wind/seismic load patterns were always displaying the response for the
first step instead of displaying the maximum story drifts from all steps. This was just a
display issue and the results using tables were correct.
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* Ticket Description
10154 An incident has been resolved in all steel frame design codes where the program used to

terminate abnormally after showing the message “An abnormal condition has occurred.
Program needs to terminate.” while displaying the design details with the form title “ETABS
Steel Frame Design”. This situation happens when the second-order analysis method is
“Amplifiedl 1st Order” and the axial compressive force in a frame member exceeds the Euler
buckling capacity, invalidating all analysis and design. The program now reports as much
information as possible with normal operations.

Section Designer
Incidents Resolved
* Ticket Description

4032 An incident was resolved where the computed torsional constant for a user-defined thin-
walled open section with fillets was slightly different when compared to the value obtained
from the Section Designer for the same section. The difference was because of different
discretization being used for the fillets when computing section properties using the two
approaches. The effect was very small. Section properties recovered from databases are not
affected.

Structural Model
Incidents Resolved
* Ticket Description

2164 An incident was resolved for the concrete stress-strain relationship based on Mander's
model in cases where the concrete modulus of elasticity (Ec) was smaller than the ratio of
concrete strength over the strain at this strength. In such situations, the Mander model
could show peculiar or undesirable behavior in the nonlinear stress-strain curve as shown in
the material properties form. Now, the concrete modulus of elasticity, if less than 1.2 times
the ratio of concrete strength over the strain at this strength, will be set to this limiting value
when it is used to generate a Mander stress-strain curve. See Technical Note - Material
Stress-Strain Curves (S-TN-MAT-001) of the documentation. Additionally, the initial value of
Ec used in the Mander model is now taken from the concrete material properties, subject to
the limit above. Previously, it was always taken as 57,000*sqrt(f'c) [psi] for the calculation of
the moment-curvature relationship in Section Designer and plastic-hinge properties.

9278 An incident was resolved where the auto-generated concrete coupling-beam shear hinges as
per ASCE 41-17 Table 10-20, Item ii, were not scaling the chord rotation correctly. The V-
Theta was being used for analysis instead of V-Delta. This only affected v21.0.0 and 21.0.1. It
was corrected for the subsequent v21.1.0 release, but was inadvertently omitted from the
Release Notes. There is no further change for the present release v21.2.0.

* 9637 An incident was resolved where a floor object assigned a property, but tagged to be only
used for mass and rigid-diaphragm assignment, was not transferring mass. This only affected
ETABS v21.0.0 and v21.1.0. Earlier versions were not affected. This issue did not occur if the
floor object was assigned a Null property, in which case the mass was properly transferred
and the rigid-diaphragm assignment also worked.

10130 An incident was resolved where the replication of objects (command Edit > Replicate) would
replicate the loads on the objects even if the option to replicate loads was not selected.

10144 An incident was resolved where duplication of mass from self-mass and self-weight has been
removed when an area object with property is completely covered with other area objects.
This is a rare modeling case. When only part of an underlying area was covered by other
area objects this duplication did not occur. It should be noted that any mass converted from
loads or any mass specified directly on areas is considered additive. The duplication is
removed only from self-mass and self-weight converted to mass. Self-weight as a load was
also not duplicated.
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User Interface
Incidents Resolved
* Ticket Description

5257 An incident was resolved where frame releases were not flipped when model was replicated
using mirror or radial replicate option and frame local axis-1 was flipped to keep the frame
local axis aligned in the positive X or Y axis.The following additional items are now flipped
where applicable: Joint offsets, moment-frame beam type (i.e., SidePlate/RBS assignment),
point load assigned to frames, partial uniform load, or variable frame load.

10146 An incident was resolved where the vertical offset for the slab rebar objects created using
the Edit > Add/Edit Slab Rebar > Add Slab Rebar menu were being referenced from the
global Z coordinate of zero instead of the specified story level. The slab rebar objects
created by drawing were not affected by this issue.


